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1 Solution Information 

SAP S/4HANA, on-premise edition - Fully Activated appliance consists of two appliances:  

1. SAP ERP 607 - Central Applications SPS08 / SAP HANA Platform Edition 1.0 - HANA DB SPS09  

2. SBOP BI Platform 4.1 - Enterprise Servers SPS05. 

 

The solution provides the following pre-activated business content scope adjusted for SAP Simple Finance 1503 

SPS1505: 

 

 Pre-configuration for SAP ERP, localized for US, Germany and China 

 Pre-configuration for Chemicals, localized for US 

 Pre-configuration for Discrete Manufacturing, localized for US 

 SAP Fiori apps 

 SAP BOBJ reports 

 Pre-configuration for SAP Access Control 

 Sample scenario using SAP Screen Personas UX technology 

Detailed information can be found on SAP Service Marketplace at http://tiny.cc/trys4h. 

 

You can explore SAP S/4HANA, on-premise Edition, starting the 30-day trial solution. The trial user guide 

https://caldocs.hana.ondemand.com/caldocs/help/S4HANAOPTRIAL_USER_GUIDE_EN.pdf  provides you with 

necessary information, such as direct system access and end-to-end business processes description.  

 

Furthermore, you can extend the usage period and expand use cases of the same solution, using the SAP Cloud 

Appliance Library subscription package.   

 

This guide provides general information on SAP S/4HANA, on-premise Edition solution - Fully Activated 

Landscape on SAP Cloud Appliance Library. It also provides information on the last steps for the configuration of 

the cloud environment, as well as initial business process evaluation in your own Demo/Evaluation Appliances. 

The landscape consists of SAP ERP with Simple Finance, SAP HANA and SAP BusinessObjects Suite. 

 

This document is not a general overview, nor is it an explanation of SAP Best Practices. For more information 

about SAP Best Practices concepts, see the related documentation on http://service.sap.com/solutionpackages 

and follow the links to the Learning Maps. 

The target group of this document are system administrators and basis consultants, who are responsible for 

system set up and preparation, including troubleshooting. They should have a sound knowledge of SAP Best 

Practices, including tools and documentation. 

 

http://tiny.cc/trys4
https://caldocs.hana.ondemand.com/caldocs/help/S4HANAOPTRIAL_USER_GUIDE_EN.pdf
http://service.sap.com/solutionpackages
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Material Numbers  

You get access to a system that has been set up using the following media: 

Number Description 

SWPM10SP08_0-

20009701.SAR SWPM10 SP08 Installation Master Linux x86_64 (SMP) 

51048902_1 SAP ERP 6.0 EHP7 SR2 Installation Export I 1/2 

51048902_2 SAP ERP 6.0 EHP7 SR2 Installation Export I 2/2 

51048902_3 SAP ERP 6.0 EHP7 SR2 Installation Export II 

51048902_4 SAP ERP 6.0 EHP7 SR2 Language I  1/2 

51048902_5 SAP ERP 6.0 EHP7 SR2 Language I  2/2 

51048902_6 SAP ERP 6.0 EHP7 SR2 Language II 1/2 

51048902_7 SAP ERP 6.0 EHP7 SR2 Language II 2/2 

51048902_8 SAP ERP 6.0 EHP7 SR2 Language III 

51049354_1 SAP HANA Platf. Ed. 1.0 SPS09 (SAP HANA DB 1.00.91) 1/2 

51049354_2 SAP HANA Platf. Ed. 1.0 SPS09 (SAP HANA DB 1.00.91) 2/2 

51049552_3 SAP Kernel 7.42 Linux on x86_64 64bit 

Components 

The solution comprises the following component versions: 

Component Release Support 

Package Stack 

Type Description 

BP-CANW 740V8 0000000000 C Tech. Obj. for SAP BP pkg. act. based on 

BP-ERP 617V6 0000000000 C SAP BP ADD-ON FOR ERP 617 

BP-SOLBLD 70V9 0000000000 C Best Practices Solution Builder on EHP5 

C-CEE 110_604 0000000025 I ECC Core Country Versions for EEM Countr 

EA-APPL 617 0008 N SAP Enterprise Extension PLM, SCM, Financials 

EA-DFPS 617 0008 N SAP Enterprise Extension Defense Forces & Public 

Security 

EA-FIN 720 0000000000 N EA-FIN 

EA-FINSERV 617 0008 N SAP Enterprise Extension Financial Services 

EA-GLTRADE 617 0008 N SAP Enterprise Extension Global Trade 

EA-HR 607 0036 N SAP Enterprise Extension HR 
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Component Release Support 

Package Stack 

Type Description 

EA-HRCAR 607 0000000032 N Sub component EA-HRCAR of EA-HR 

EA-HRCAT 607 0000000032 N Sub component EA-HRCAT of EA-HR 

EA-HRCAU 607 0000000032 N Sub component EA-HRCAU of EA-HR 

EA-HRCBE 607 0000000032 N Sub component EA-HRCBE of EA-HR 

EA-HRCBR 607 0000000032 N Sub component EA-HRCBR of EA-HR 

EA-HRCCA 607 0000000032 N Sub component EA-HRCCA of EA-HR 

EA-HRCCH 607 0000000032 N Sub component EA-HRCCH of EA-HR 

EA-HRCCL 607 0000000032 N Sub component EA-HRCCL of EA-HR 

EA-HRCCN 607 0000000032 N Sub component EA-HRCCN of EA-HR 

EA-HRCDE 607 0000000032 N Sub component EA-HRCDE of EA-HR 

EA-HRCDK 607 0000000032 N Sub component EA-HRCDK of EA-HR 

EA-HRCES 607 0000000032 N Sub component EA-HRCES of EA-HR 

EA-HRCFI 607 0000000032 N Sub component EA-HRCFI of EA-HR 

EA-HRCFR 607 0000000032 N Sub component EA-HRCFR of EA-HR 

EA-HRCGB 607 0000000032 N Sub component EA-HRCGB of EA-HR 

EA-HRCHK 607 0000000032 N Sub component EA-HRCHK of EA-HR 

EA-HRCID 607 0000000032 N Sub component EA-HRCID of EA-HR 

EA-HRCIE 607 0000000032 N Sub component EA-HRCIE of EA-HR 

EA-HRCIN 607 0000000032 N Sub component EA-HRCIN of EA-HR 

EA-HRCIT 607 0000000032 N Sub component EA-HRCIT of EA-HR 

EA-HRCJP 607 0000000032 N Sub component EA-HRCJP of EA-HR 

EA-HRCKR 607 0000000032 N Sub component EA-HRCKR of EA-HR 

EA-HRCKW 607 0000000032 N Sub component EA-HRCKW of EA-HR 

EA-HRCKZ 607 0000000032 N Sub component EA-HRCKZ of EA-HR 

EA-HRCMX 607 0000000032 N Sub component EA-HRCMX of EA-HR 

EA-HRCMY 607 0000000032 N Sub component EA-HRCMY of EA-HR 

EA-HRCNL 607 0000000032 N Sub component EA-HRCNL of EA-HR 

EA-HRCNO 607 0000000032 N Sub component EA-HRCNO of EA-HR 

EA-HRCNZ 607 0000000032 N Sub component EA-HRCNZ of EA-HR 

EA-HRCOM 607 0000000032 N Sub component EA-HRCOM of EA-HR 
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Component Release Support 

Package Stack 

Type Description 

EA-HRCPH 607 0000000032 N Sub component EA-HRCPH of EA-HR 

EA-HRCPT 607 0000000032 N Sub component EA-HRCPT of EA-HR 

EA-HRCQA 607 0000000032 N Sub component EA-HRCQA of EA-HR 

EA-HRCRU 607 0000000032 N Sub component EA-HRCRU of EA-HR 

EA-HRCSE 607 0000000032 N Sub component EA-HRCSE of EA-HR 

EA-HRCSG 607 0000000032 N Sub component EA-HRCSG of EA-HR 

EA-HRCTH 607 0000000032 N Sub component EA-HRCTH of EA-HR 

EA-HRCTW 607 0000000032 N Sub component EA-HRCTW of EA-HR 

EA-HRCUN 607 0000000032 N Sub component EA-HRCUN of EA-HR 

EA-HRCUS 607 0000000032 N Sub component EA-HRCUS of EA-HR 

EA-HRCVE 607 0000000032 N Sub component EA-HRCVE of EA-HR 

EA-HRCZA 607 0000000032 N Sub component EA-HRCZA of EA-HR 

EA-HRGXX 607 0000000032 N Sub component EA-HRGXX of EA-HR 

EA-HRRXX 607 0000000032 N Sub component EA-HRRXX of EA-HR 

EA-IPPE 617 0000000004 P SAP iPPE 

EA-PS 617 0008 N SAP Enterprise Extension Public Services 

EA-RETAIL 617 0008 N SAP Enterprise Extension Retail 

EAPPLGLO 607 0011 I Globalization Extension ERP Financial 

EAPSGLO 607 0011 I Globalization Extension Public Sector 

ECC-DIMP 617 0008 I DIMP 

ECC-SE 605 0000000013 I ECC-SE 

ERECRUIT 617 0000000007 I E-Recruiting 

FI-CA 617 0008 I FI-CA 

FI-CAX 617 0008 I FI-CA Extended 

FINBASIS 747 0008 N Financial Basis 

FSCM_CCD 720 0000000000 N FSCM_CCD 

GBAPP002 600 0009 H GBAPP002 

GBHCM002 600 0015 H HCM Employee Requests (Leave) 

GBHCM003 600 0000000012 H HCM Manager Approvals (Time, Training, L 

GRCFND_A V1100 0009 V GRC Foundation ABAP 
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Component Release Support 

Package Stack 

Type Description 

GRCPIERP V1100_70

0 

0009 H GRCPIERP 

GRCPINW V1100_731 0009 V SAP GRC NetWeaver Plug-In 

INSURANCE 617 0008 I SAP Insurance 

IS-CWM 617 0008 I Industry Solution Catch Weight Management 

IS-H 617 0012 I SAP Healthcare 

IS-M 617 0008 I SAP MEDIA 

IS-OIL 617 0008 I IS-OIL 

IS-PRA 617 0009 I SAP IS-PRA 

IS-PS-CA 617 0008 I IS-PUBLIC SECTOR CONTRACT ACCOUNTING 

IS-UT 617 0008 I SAP Utilities/Telecommunication 

IW_GIL 100 0006 V Generic Interaction Layer 

IW_PGW 100 0000000006 V Process Gateway 

LSOFE 617 0000000006 I SAP Learning Solution Front-End 

MDG_APPL 617 0008 R MDG Applications 

MDG_FND 747 0008 V MDG Foundation 

PERSONAS 300 0000 C PERSONAS - SAP GUI PERSONALISATION 

PI_BASIS 740 0000000010 X Basis Plug-In 

PLMWUI 747 0008 I SAP PLM Web UI 

SAP_ABA 740 0000000010 S Cross-Application Component 

SAP_AP 700 0000000032 V SAP Application Platform 

SAP_APPL 617 0008 R Logistics and Accounting 

SAP_BASIS 740 0000000010 S SAP Basis Component 

SAP_BS_FND 747 0008 V SAP Business Suite Foundation 

SAP_BW 740 0000000010 W SAP Business Warehouse 

SAP_FIN 720 0001 R SAP_FIN 

SAP_GWFND 740 0000000010 S SAP Gateway Foundation 

SAP_HR 604 0085 R Human Resources 

SAP_HRCAR 604 0000000081 R Sub component SAP_HRCAR of SAP_HR 

SAP_HRCAT 604 0000000081 R Sub component SAP_HRCAT of SAP_HR 

SAP_HRCAU 604 0000000081 R Sub component SAP_HRCAU of SAP_HR 
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Component Release Support 

Package Stack 

Type Description 

SAP_HRCBE 604 0000000081 R Sub component SAP_HRCBE of SAP_HR 

SAP_HRCBR 604 0000000081 R Sub component SAP_HRCBR of SAP_HR 

SAP_HRCCA 604 0000000081 R Sub component SAP_HRCCA of SAP_HR 

SAP_HRCCH 604 0000000081 R Sub component SAP_HRCCH of SAP_HR 

SAP_HRCCL 604 0000000081 R Sub component SAP_HRCCL of SAP_HR 

SAP_HRCCN 604 0000000081 R Sub component SAP_HRCCN of SAP_HR 

SAP_HRCDE 604 0000000081 R Sub component SAP_HRCDE of SAP_HR 

SAP_HRCDK 604 0000000081 R Sub component SAP_HRCDK of SAP_HR 

SAP_HRCES 604 0000000081 R Sub component SAP_HRCES of SAP_HR 

SAP_HRCFI 604 0000000081 R Sub component SAP_HRCFI of SAP_HR 

SAP_HRCFR 604 0000000081 R Sub component SAP_HRCFR of SAP_HR 

SAP_HRCGB 604 0000000081 R Sub component SAP_HRCGB of SAP_HR 

SAP_HRCHK 604 0000000081 R Sub component SAP_HRCHK of SAP_HR 

SAP_HRCID 604 0000000081 R Sub component SAP_HRCID of SAP_HR 

SAP_HRCIE 604 0000000081 R Sub component SAP_HRCIE of SAP_HR 

SAP_HRCIN 604 0000000081 R Sub component SAP_HRCIN of SAP_HR 

SAP_HRCIT 604 0000000081 R Sub component SAP_HRCIT of SAP_HR 

SAP_HRCJP 604 0000000081 R Sub component SAP_HRCJP of SAP_HR 

SAP_HRCKR 604 0000000081 R Sub component SAP_HRCKR of SAP_HR 

SAP_HRCKW 604 0000000081 R Sub component SAP_HRCKW of SAP_HR 

SAP_HRCKZ 604 0000000081 R Sub component SAP_HRCKZ of SAP_HR 

SAP_HRCMX 604 0000000081 R Sub component SAP_HRCMX of SAP_HR 

SAP_HRCMY 604 0000000081 R Sub component SAP_HRCMY of SAP_HR 

SAP_HRCNL 604 0000000081 R Sub component SAP_HRCNL of SAP_HR 

SAP_HRCNO 604 0000000081 R Sub component SAP_HRCNO of SAP_HR 

SAP_HRCNZ 604 0000000081 R Sub component SAP_HRCNZ of SAP_HR 

SAP_HRCOM 604 0000000081 R Sub component SAP_HRCOM of SAP_HR 

SAP_HRCPH 604 0000000081 R Sub component SAP_HRCPH of SAP_HR 

SAP_HRCPT 604 0000000081 R Sub component SAP_HRCPT of SAP_HR 

SAP_HRCQA 604 0000000081 R Sub component SAP_HRCQA of SAP_HR 
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Component Release Support 

Package Stack 

Type Description 

SAP_HRCRU 604 0000000081 R Sub component SAP_HRCRU of SAP_HR 

SAP_HRCSE 604 0000000081 R Sub component SAP_HRCSE of SAP_HR 

SAP_HRCSG 604 0000000081 R Sub component SAP_HRCSG of SAP_HR 

SAP_HRCTH 604 0000000081 R Sub component SAP_HRCTH of SAP_HR 

SAP_HRCTW 604 0000000081 R Sub component SAP_HRCTW of SAP_HR 

SAP_HRCUN 604 0000000081 R Sub component SAP_HRCUN of SAP_HR 

SAP_HRCUS 604 0000000081 R Sub component SAP_HRCUS of SAP_HR 

SAP_HRCVE 604 0000000081 R Sub component SAP_HRCVE of SAP_HR 

SAP_HRCZA 604 0000000081 R Sub component SAP_HRCZA of SAP_HR 

SAP_HRGXX 604 0000000081 R Sub component SAP_HRGXX of SAP_HR 

SAP_HRRXX 604 0000000081 R Sub component SAP_HRRXX of SAP_HR 

SAP_UI 740 0000000012 S User Interface Technology 

SEM-BW 747 0008 I SEM-BW: Strategic Enterprise Management 

SFDM_ABAP 100 0000000004 I SFDM On ABAP 1.0 

SRA001 600 0007 H Approve Purchasing Contracts OData Integ 

SRA002 600 0008 H Time Recording OData Integration Compone 

SRA003 600 0000000003 H Create Travel Expenses OData Integration 

SRA004 600 0007 H Create Travel Request OData Integration 

SRA006 600 0008 H Remuneration Statements OData Integratio 

SRA007 600 0000000006 H My Benefits Enrollment OData Integration 

SRA008 600 0008 H Approve Travel Expenses OData Integratio 

SRA009 600 0007 H Approve Travel Requests OData Integratio 

SRA010 600 0000000007 H Staffing List OData Integration Componen 

SRA012 600 0000000005 H My Department Spend 

SRA013 600 0000000007 H Create Purchase Order from Released Purc 

SRA016 600 0008 H Price and Availability Check OData Integ 

SRA017 600 0007 H Create Purchase Order OData Integration 

SRA018 600 0007 H Purchase Order Status Tracking OData Int 

SRA019 600 0000000005 H Track Shipment OData Integration Compone 

SRA020 600 0000000007 H Purchase Order Status (In Process, Appro 
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Component Release Support 

Package Stack 

Type Description 

SRA021 600 0007 H Customer Invoices OData Integration Comp 

ST-PI 740 0000000001 X SAP Solution Tools Plug-In 

UIAPFI70 200 0001 H UI SFIN 

UIEAAP01 100 0006 H UI for ERP Central Applications 

UIGRC001 100 0000000005 H UI for GRC 

UIHERP01 100 0000000003 H UI Hana Live Content for ERP 

UIHGRC01 100 0003 H Fiori/Hana Live Content for SAP GRC 

UISAFND1 100 0000000000 H Frontend Server Content for Smart Business for 

ANALYTICS FOUNDATION 100 

UISERP01 100 0006 H UI Smart Business Content for ERP 

UISKPI01 100 0000000003 H UI Smart Business Content for KPI 

UIX01CA1 100 0005 H UI for Cross-Applications 

UIX01EAP 100 0006 H UI for ERP Central Applications 

UIX01HCM 100 0006 H UI for HCM Application 

UIX01TRV 100 0005 H UI for Travel Application 

WEBCUIF 747 0008 V SAP Web UI Framework 

Sizing Information  

Regarding minimum sizing, consult SAP Note 2032086. 

Sizing information should be considered for on-premise deployment. 

Follow the sizing guidelines to determine the hardware requirements of the solution such as network bandwidth, 

physical memory, CPU power, and I/O capacity by choosing this quick link: http://service.sap.com/sizing  

 Sizing  Sizing Guidelines 

You can also use the search function in the Quick Sizer tool to find your required sizing guidelines. 

OS Compatibility Information 

Check the Product Availability Matrix (PAM) to determine the operating system requirements needed to run the 

SAP system. For more information, find the details of the OS environment on which this solution has been set up 

in the table below: 

 

http://service.sap.com/sap/support/notes/2032086
http://service.sap.com/sizing
http://service.sap.com/
http://support.sap.com/pam
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Name Value 

OS Kernel 

Version 

3.0.101-0.31-default 

OS Version 11 

OS Platform linuxx86_64 

OS Release SUSE Linux Enterprise Server 11 (x86_64) 

GLIBC Version 2.11.3 

OS Type SUSELinux 

OS Patch Level 3 

Architecture x86_64 

SAP Host Agent Information 

It is highly recommended to have the latest version of SAP Host Agent. Find more information in the related SAP 

Notes listed below: 

 1) SAP Note 1031096 - Installing Package SAPHOSTAGENT 

2) SAP Note 1473974 - Using the SAP Host Agent Auto Upgrade Feature 

Parameter and User-Id Summary 

This section provides an overview on all relevant system parameters and user-IDs.  

 

Parameter Description Parameter Value Note 

Master Password <Master Password> You specify the master password during 

the creation of the instance in the SAP 

Cloud Appliance Library. 

Server domain  <Domain Name> Domain name as specified in your VPC 

DHCP Option Set. 

Private key  <Private Key File> The private key file is provided during the 

creation of the instance in the SAP Cloud 

Appliance Library. It should be used for 

SSH access to the host. 

Server IP Address <IP Address> IP address of your instance from the SAP 

Cloud Appliance Library. 

Host name vhcalhdbdb, vhcalerpci, 

vhcalerpcs, vhcalwdpwd 

bihost 

Predefined name of the host on which 

HANA, ABAP, Web Dispatcher and BIP are 

running. 

http://service.sap.com/sap/support/notes/1031096
http://service.sap.com/sap/support/notes/1473974
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Parameter Description Parameter Value Note 

Root user / password root / <Private Key File> Default OS Administrator user for Linux 

SUSE.  

HDB System ID HDB - 

HDB Instance Number 02 - 

DB User / Password SYSTEM / <Master 

Password> 

SAPERP / <Master 

Password> 

BPINST / Welcome1 

- 

ABAP System ID ERP - 

ABAP Instance number 00 - 

ABAP Client/ User / Password 000 / SAP*  / <Master 

Password>  

000 / DDIC  / <Master 

Password> 

 

001 / SAP*  / <Master 

Password> 

001 / DDIC  / <Master 

Password> 

- 

ABAP Administrator OS level / 

Password 

erpadm / <Master 

Password> 

- 

SAP System Administrator sapadm / <Master 

Password> 

- 

Diagnostic Agent User daaadm / <Master 

Password> 

- 

BIP User / Password administrator / Welcome1 - 

OS Users and Groups 

If you need OS access, you must use SSH connectivity. Use the default user root and the private key for the 

instances, which are downloaded while your landscaped instance is activated from SAP Cloud Appliance Library. 

Parameter ID Parameter Value Note 

OS User Name root The default OS Administrator user for Linux 

SUSE. 

OS Password <none> Use the private key (downloaded during the 

activation of the instance in SAP Cloud 

Appliance Library) to log on with root user. 
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The administration users for HANA, ABAP and BOBJ on operating system level are defined as follows:  

Parameter ID Parameter Value Note 

HANA administrator name hdbadm Additional user for HANA lifecycle 

management – start/stop, administration, 

functions, recovery. 

HANA administrator password <Master Password> The password is the same as the master 

password provided during instance creation in 

the SAP Cloud Appliance Library. 

ABAP administrator name erpadm Additional user for ABAP lifecycle management 

– start/stop, administration, functions, 

recovery. 

ABAP administrator password <Master Password> The password is the same as the master 

password provided during instance creation in 

the SAP Cloud Appliance Library. 

BOBJ administrator name bipadm Additional user for BOBJ lifecycle management 

– start/stop,  administration, functions, 

recovery 

BOBJ administrator password <Master Password> The password is the same as the master 

password provided during instance creation in 

the SAP Cloud Appliance Library. 

 

Additional users on operating system level are:  

Parameter ID Parameter Value Note 

SAP System Administrator sapadm  

SAP System Administrator 

password 

<Master Password> The password is the same as the master 

password provided during instance 

creation in the SAP Cloud Appliance 

Library. 

<SID>adm User Group sapsys Group containing all <SID>adm users 

(should be a group in a central user 

storage like LDAP, NIS, or Active 

Directory) 

SAP System Administrator daaadm  

SAP System Administrator 

password 

<Master Password> The password is the same as the master 

password provided during instance 

creation in the SAP Cloud Appliance 

Library. 
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2 Solution Provisioning in SAP Cloud 
Appliance Library 

If you have a user in SAP Cloud Appliance Library, you need to meet the following prerequisites before starting to 

use SAP Cloud Appliance Library: 

 

- Cloud Provider Configurations 

You have a valid account in one of the cloud providers supported by SAP Cloud Appliance Library. If you already 

have an active cloud provider account, you can proceed directly with the next section. Otherwise, navigate to the 

cloud provider home page and sign up. 

For more information about the supported cloud providers, see  FAQ page. 

 

- Navigate to SAP Cloud Appliance Library 

Open SAP Cloud Appliance Library in your web browser using the following link: https://cal.sap.com  

For more information on how to use solutions in SAP Cloud Appliance Library, see the official documentation of 

SAP Cloud Appliance Library (choose the Support  Documentation link and select the   (Expand all) button to 

see all documents in the structure). You can also use the context help in SAP Cloud Appliance Library by choosing  

Help panel on the right side of the screen.

http://scn.sap.com/docs/DOC-33673
https://cal.sap.com/
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3  Installing Client Software 

3.1 ABAP Client Software 

Ensure that you have installed the latest and appropriate SAP frontend components.   

The download path below leads you to an overview on how to install SAP frontend components and how to apply 

patches. On the navigation level SAP Frontend Components, you can select the SAP frontend components 

depending on your requirements. 

To download the SAP frontend components, go to the Software Distribution Center (SWDC) on the SAP Service 

Marketplace. 

3.1.1 SAP GUI 

Ensure that you have installed the latest version of SAP GUI and of the SAP Scripting Engine. 

Open the SWDC page https://support.sap.com/swdc. Go to Support Packages and Patches   Browse our 

Download Catalog   SAP Frontend Components.   

3.1.2 SAP NetWeaver Business Client (optional) 

Open the SWDC page https://support.sap.com/swdc. Choose Support Packages and Patches  and go to Browse 

our Download Catalog   SAP Frontend Components   Netweaver Business Client   NWBC NW Business 

Client 4.0. 

3.1.3 ABAP Development Tools (ADT) (optional) 

The installation package for the ABAP Development Tools (ADT) can be found at 

https://tools.hana.ondemand.com/ . You can use the HANA Studio (Revision 74 or higher) as Eclipse platform. 

3.2 SAP HANA Studio and SAP HANA Client 

For detailed instructions, refer to http://help.sap.com/hana_platform. Please check especially the SAP HANA 

Client Installation Guide. The SAP HANA Client has to be installed for all the users who will access the data in 

HANA by using some kind of frontend tools, as for example Excel, BOBJ Clients, etc. 

The software package containing the SAP Hana Studio includes the SAP HANA Administration and Modeling tool. 

https://service.sap.com/swdc
https://service.sap.com/swdc
https://tools.hana.ondemand.com/
http://help.sap.com/hana_platform
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The software package containing the SAP HANA Client includes SDK's for JDBC, ODBC, ODBO and Python DB 

API, so that you can build client applications.  

You can download the SAP HANA Studio and Client for all available operating systems from the SAP Support 

Portal by using the following procedure: 

1. On your browser, enter the following URL for the SAP Support Portal: http://support.sap.com/swdc  

Choose Software Downloads  search for Software  (link on the right hand side)   

2. In the Search Term field, enter the following string:  

1. for the SAP HANA Studio:  IMC_STUDIO100 

2. for the SAP HANA Client:   IMDB_CLIENT100 

3. Choose Search. 

4. From the list of archives, download the archive according to your OS and the latest revision (e.g. 

IMC_STUDIO100_nn – nn is the revision number). 

5. Unpack the files with SAPCAR and run the hdbsetup.exe installers. 

3.3 SAP BusinessObjects BI Platform Client Tools (optional) 

To view the reports from HANA Live RDS V5, there is no installation needed from client side. As long as you have a 

browser and access to the BI Platform, you can view the report results. 

To adopt reports in your BusinessObjects Enterprise system, you must install SAP BusinessObjects BI platform 

client tools on your local windows environment. 

To download SAP BusinessObjects BI platform client tools 4.1 SP05, go to the SAP Software Download Center 

(SWDC) on SAP Support Portal: https://support.sap.com/swdc  

Software Download   Installation and Upgrades  Browse Our Download Catalog  Analytics Solutions  

 SBOP BUSINESS INTELLIGENCE PLATFORM (SBOP ENTERPRISE)   SBOP BI PLATFORM (ENTERPRISE)  

 SBOP BI PLATFORM 4.1  Installation and Upgrades  WINDOWS 

 

http://support.sap.com/swdc
https://service.sap.com/swdc
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4 Connecting to Your Solution 

4.1 Connecting to SAP ERP / SAP HANA 

4.1.1 Release and Support Package level 

[Main Component]:  SAP HANA Platform Edition 1.0 

[Stack-no. of Main Component]: SPS09 

[Localized Country]: USA 

[Language]: EN 

 

[Main Component]: SAP enhancement package 7 for SAP ERP 6.0 

[Stack-no. of Main Component]: SPS08 

[Localized Country]: US, Germany, China 

[Language]: all standard languages 

4.1.2 Mapping hostnames to IP address 

 Your Amazon VPC setup needs to have a DHCP Option Set, which defines a domain-name 

<Domain Name>. If this is not the case, create the DHCP Option set, terminate your CAL instance and 

create a new one. This is necessary as <Domain Name> is used in the CAL instance creation process.  

 

When creating a CAL instance, the solution is deployed to a server with the predefined virtual host names 

vhcalhdbdb, vhcalerpci, and vhcalerpcs and to a second server with the virtual host name bihost. You are also 

provided with <IP Addresses> that allow you to access the servers. You can find the <IP Address> of the 

respective servers by selecting the name of your instance in the SAP Cloud Appliance Library. ABAP application 

server ERP and BI platform server BIHOST reach the HANA server HDB with the help of an entry for vhcalhdbdb  

in its local /etc/hosts file.  

You still need to publish a mapping between the server names and the IP address in your network. You could do 

this within your Domain Name Service (DNS) setup or adjust the hosts file on the client.  

 

The following steps describe how to adjust the hosts file on the client:  

 

3. Open the hosts file of your operating system as administrator: 

o For Windows operating system: Open the Start menu, type  

notepad c:\windows\system32\drivers\etc\hosts  

and hit Ctrl Shift Enter.  
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o For Linux operating system: /etc/hosts 

 

4. Enter the following lines in the hosts file and save it: 

# ERP and HDB 

<IP Address ERP/HDB server> vhcalerpci vhcalerpci.<Domain Name> 

<IP Address ERP/HDB server> vhcalerpcs vhcalerpcs.<Domain Name> 

<IP Address ERP/HDB server> vhcalhdbdb vhcalhdbdb.<Domain Name> 

# BI Platform 

<IP Address BI Host server> bihost bihost.<Domain Name> 

 

The predefined local domain name is dummy.nodomain. If you do not want to change the default settings, you 

can map the hosts name to IP addresses as the following: 

 

# ERP and HDB 

<IP Address ERP/HDB server>   vhcalerpcs vhcalerpcs.dummy.nodomain  vhcalerpci 

vhcalerpci.dummy.nodomain vhcalhdbdb vhcalhdbdb.dummy.nodomain 

# BI Platform 

<IP Address BI Host server> bihost bihost.dummy.nodomain 

 

Working with the dummy.nodomain might require changes in your web browser in case there is a web proxy in 

place. You need to set the Proxy Server as follows: 

Address <your proxy server> for 

example proxy 

Port <your proxy port> for example 

8080 

 

Furthermore, you need to add the following to the Exceptions field: *.dummy.nodomain  

 

In Microsoft Internet Explorer e.g., open Tools → Internet Options. Go to the Connections tab and 

choose LAN settings . 

 

In the Proxy server section, carry out the following steps:  

- Check Use a proxy server for your … 

- Maintain Address and Port 

- Choose the Advanced button. 

 

In section Exceptions, carry out the following steps: 

- Add ;*.dummy.nodomain at the end of the entry field. 

- Choose the OK  button. 
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4.1.3 Connecting to ABAP via SAP GUI 

Procedure 

1. Start the SAP Logon. 

2. Choose New entry  User defined.  

3. In the System wizard, specify the following parameters: 

 

Parameter ID Parameter Value Note 

Application Server <IP Address> The IP address of the ERP instance from 

SAP  Cloud Appliance Library 

Instance Number 00 ABAP instance number used by the 

appliance. 

System-ID ERP ABAP system id used by the appliance. 

User Names and 

Passwords 

Client 000: SAP*, <Master Password> 

Client 000: DDIC, <Master Password> 

Client 001: SAP*, <Master Password> 

Client 001: DDIC, <Master Password> 

 

Default users 

 

 

Client 100 (BW client): BPINST, 

Welcome1 

Client 102 (Germany): BPINST, 

Welcome1 

Client 114 (China): BPINST, Welcome1 

Client 120 (US*): BPINST, Welcome1 

Client 180 (GW + AC): BPINST, 

Welcome1 

* US also contains the activated 

baselines  

  for Chemicals industry and  

  Discrete Manufacturing industry 

Activation / evaluation user for the 

different country clients 

4.1.4 Connecting to HANA via SAP HANA Studio  

Procedure 

1. Start the installed SAP HANA Studio. 
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2. Open the Navigator view and right click on this view. Then choose Add System. 

3. In the System wizard, specify the following parameters: 

 

Parameter ID Parameter Value Note 

Hostname <IP Address> The IP address of the HANA instance from the SAP  Cloud 

Appliance Library 

Instance Number 02 HANA instance number used for the appliance. 

User Name BPINST For the connection to the DB 

Password Welcome1  

 

The system ID of the database is HDB. It is recognized automatically via the host name. 

4.1.5 Connecting to Fiori Launchpad  

The Fiori Launchpad follows the standard address format: https://<hostname>.<domain 

name>:<port>/sap/bc/ui5_ui5/ui2/ushell/shells/abap/fiorilaunchpad.html 

 

After you have mapped the IP address and hostname, you can access the default Fiori Launchpad at the link 

below, in case you have not changed any settings: 

https://vhcalerpcs.dummy.nodomain:44301/sap/bc/ui5_ui5/ui2/ushell/shells/abap/fiorilaunchpad.html 

In case you have problems to access HTML GUI tile, you can also access the Fiori Launchpad via: 

https://vhcalerpci.dummy.nodomain:44301/sap/bc/ui5_ui5/ui2/ushell/shells/abap/fiorilaunchpad.html 

 

Parameter ID Parameter Value Note 

User Name BPINST For the connection to the DB 

Password Welcome1  

Client  102 - DE 

114 - CN 

120 - US 

Depending on your desired client 

 

https://vhcalerpcs.dummy.nodomain:44301/sap/bc/ui5_ui5/ui2/ushell/shells/abap/fiorilaunchpad.html
https://vhcalerpci.dummy.nodomain:44301/sap/bc/ui5_ui5/ui2/ushell/shells/abap/fiorilaunchpad.html
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4.2 Connecting to SAP BusinessObjects BI Platform 

4.2.1 Connecting to BI Launchpad  

Procedure 

If you have configured your own domain and ports, please refine your own BI Launchpad address as the following: 

https://bihost:<port>/BOE/BI 

If you have not changed the predefined domain and ports, you can use the default access: 

https://bihost:8443/BOE/BI  

 

Parameter ID Parameter Value Note 

Authentication  Enterprise   

User BPINST  

Password Welcome1  

 

 

4.2.2 SAP BusinessObjects Enterprise System Setup and 
Preparation 

4.2.2.1 Release and Support Package level 

The deliverables of SAP packages were developed and tested in a system landscape with specific release and 

support package (SPS) levels. When connecting other systems to this image, check the required product versions 

of this solution below. 

 

 [Main Component]: SBOP BI PLATFORM 4.1 

[Stack-No. of Main Component]: Support Package Stack 05 

[Localized Country]: All 

[Language]: All 

https://bihost:%3cport%3e/BOE/BI
https://bihost:8443/BOE/BI
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4.2.3 Check SAP BusinessObjects BI Platform Version 

Procedure 

1. Logon to SAP BusinessObjects Enterprise Console.  

If you have not changed the predefined domain and ports, you can use the default access: 

https://bihost:8443/BOE/CMC.  

If you have configured your own domain and ports, please refine your own BI Launchpad address as the 

following: https://bihost:<port>/BOE/CMC.  

On the Logon screen, first select Enterprise as Authentication type, and enter your user name and 

password. 

2. In the upper-right corner, expand Help and choose About. 

3. You will see a detailed product information and the corresponding version. 

4.2.4 Check SAP BusinessObjects BI Platform Status 

Procedure 

1. Logon to SAP BusinessObjects Enterprise Console.  

2. Choose Monitoring from the drop down list under Central Management Console. 

3. Check for Overall Health and Individual Server Health. All servers should have status OK with green light. 

4. The processes below are only needed if you find individual servers with a red/gray light:  

5. Choose Servers from drop down list under Central Management Console. 

6. Go to Nodes. 

7. Right click on bihost and choose Restart Server. 

8. Right click on bihost again and choose Enable Server. 

 

https://bihost:8443/BOE/CMC
https://bihost:%3cport%3e/BOE/CMC
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5 Evaluate Business Content and Processes 
for Pre-Deployed Scenarios 

On the Service Market Place pages for SAP S/4HANA, on-premise enterprise edition (http://tiny.cc/trys4h), you 

have access to all relevant documents and links for each Rapid-deployment Solution that is included. 

You can access the business process documentation (BPD) for each process through the Content Libraries of the 

Rapid-deployment Solutions. 

 

  

Use the Demo Guide and the business process documentation (BPD) of the different Rapid-deployment Solutions 

to evaluate the processes in the system.  

 

  

If you want to use SAP HANA Live reports you have to refer to the ERP / baseline master data. 

 

http://tiny.cc/trys4
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6 Security Aspects 

Be aware that creating your instances in the public zone of your cloud computing platform is convenient, but less 

secure. Ensure that only port 22 (SSH) is opened while working with Linux-based solutions, and that only port 

3389 (RDP) is opened while working with Windows based solutions. In addition, we also recommend you to limit 

the access to your instances by defining a specific IP range in the Access Points settings, using CIDR notation. A 

more complex, but also more secure alternative is to set up a virtual private cloud (VPC) with VPN access, as 

described in this tutorial on SCN. 

The list below describes the ports opened for the security group formed by the server components of your 

solution instance. To access back-end servers on the operating system (OS) level, use the following information: 

 

Protocol Port Description 

SSH 22 Used for SSH connection to Linux-based servers 

 

You must change the initial user passwords provided by SAP when you log on to the system for the first time. 

 

Note that when using HANA based appliances, HANA systems are not installed individually, but cloned from a 

template system. As a consequence of this cloning process, the existing root keys are cloned. For more 

information, see this: SAP Note 2134846 - HANA encryption key handling during system cloning. 

General Security Guidelines 

To access the latest version of the SAP ERP Central Component Security Guide, please refer to this link on the 

SAP Help Portal. 

To access the latest version of the SAP BusinessObjects Platform 4.1 SPS05 security guide, please refer to this 

link on the SAP Help Portal. 

 

 

 

  

 

http://en.wikipedia.org/wiki/Classless_Inter-Domain_Routing
http://scn.sap.com/docs/DOC-57869
http://service.sap.com/sap/support/notes/2134846
http://help.sap.com/saphelp_erp60_sp/helpdata/en/cb/116f414cda167de10000000a155106/content.htm?frameset=/en/cb/116f414cda167de10000000a155106/frameset.htm
http://help.sap.com/businessobject/product_guides/sbo41/en/sbo41sp5_bip_admin_en.pdf
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